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Preface

1. Foreword
When we at Ademero set out to design a document management system, we wanted to provide the
framework and feature set that you the user have requested over the years. We believe Content Central
has accomplished just that. We respect your thoughts and opinions and consider all feedback we receive
from our customers. Always feel free to drop us a line via phone, Web, or e-mail. Customer satisfaction
is our primary goal.

We've attempted to write this documentation in a way that provides concepts and definitions first and
foremost before instructions. If for any reason any part of this document is unclear or the product does
not perform as indicated or expected, please contact our support center below for a quick response and
resolution to the issue you're experiencing. We pride ourselves on customer service; that's why we offer
our support to you 24 hours-a-day, 7 days-a-week on any day of the year.

Ademero Support Channels

Phone (863) 937-0272

Toll-Free (888) 276-2914

E-mail support@ademero.com [mailto:support@ademero.com]

Web Site http://www.ademero.com/

2. Content Central Concepts
This section identifies the key concepts behind how this document management system operates. This
information will help you throughout the rest of this document.

2.1. Documents

A document is represented as a file on the file system. What sets a document apart from other files is its use.
documents usually contain text or other data that can be searched for retrieval. Common document formats
include PDF [Definition: Portable Document Format], Microsoft® Word®, and Microsoft® Excel®.
Some document formats contain content and/or metadata that may be inherited when imported. For a full
list of these file types, see Appendix A, Supported File Types with Existing Content.

Document properties, also known as index fields, tags, or metadata, provide a classification system that
helps you find documents more quickly and accurately in Content Central.

Note

Ademero strongly recommends the use of document properties when capturing information.

When paper images have been captured from a scanner or other input device, Content Central converts
them to PDF files. The PDF format conveniently stores images, text, and document properties in one file.

mailto:support@ademero.com
mailto:support@ademero.com
http://www.ademero.com/
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2.2. Document Types
Each document is described by a document type, which serves as a template for the document. Unique
security permissions, fields for document properties, and more can be defined at the document-type level.
Each document inherits these settings when captured.

2.3. Catalogs
A catalog contains information about a related set of documents in the system. You can create as many
catalogs as needed. Catalogs usually take the form of an existing business department or business process.
The information stored in a catalog is as follows:

• Document types

• User & Group Permissions

• Fields (metadata)

• Text-Recognition Zones (Zonal OCR)

• Barcode-Recognition Zones (Zonal Barcode)

• Field-Lookup Integration

• Approval Processes [Enterprise Edition]

• Workflow Rules [Enterprise Edition]

• Message Templates [Enterprise Edition]

• Folder & File Building

• Capture Forms

• Retention Policy

• Search & Results Display Fields

• Documents

• Document Name (file name)

• Document Location (file path)

• Document properties (metadata)

• Document Text (full text of a text-supported file format or OCR [Definition: Optical Character
Recognition] from a captured image of a paper document)

Catalogs are created and managed by Content Central and are stored within the SQL database designated
for Content Central.

2.4. Capture Types
DirectScan™ (Browser) This Java™ applet allows users to scan paper into the Web browser

using a TWAIN-compliant scanner.
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QCard™ (Browser, Monitored
Folder, E-mail)

QCards™ contain barcodes used to identify individual paper
documents in a batch. Users create and print QCards™ from their
Web browser. QCard™-attached documents can be scanned to the
Web browser using the DirectScan™ applet, saved to a monitored
folder, or sent to a monitored e-mail address.

CustomBarcode (Browser,
Monitored Folder, E-mail)

Pages containing barcodes may be used to identify the beginning
of paper documents in a batch. The information provided within
the barcodes may be assigned to field data automatically. The
paper documents can be scanned to the Web browser using the
DirectScan™ applet, saved to a monitored folder, or sent to a
monitored e-mail address.

PDF Form (AcroForm/XFA)
(Browser)

New documents can be generated by filling out a PDF form based
on a template in the system.

Drag & Drop Upload (Browser) Users can drag one or more folders and files to one of two Java™
applets in the Web browser.

Single Upload (Browser) Users can browse to a single file, classify it if desired, and upload
it using the Web browser.

Multi Upload (Browser) Users can browse to one or more folders and files and upload them
using the Web browser.

Electronic (Monitored Folder, E-
mail)

Files can be saved to a monitored folder or sent to a monitored e-
mail address. They will be left in their native format and can be
routed to either the Coding Queue or directly to a catalog.

Image-Only (Monitored Folder, E-
mail)

Scanned images (TIFF, PDF, JPEG, BMP, PNG, GIF) can be saved
to a monitored folder or sent to a monitored e-mail address. They
will be converted to fully-searchable PDF files and can be routed
to either the Coding Queue or directly to a catalog.

XML (Monitored Folder, E-mail) Files can be identified with XML descriptors and saved to a
monitored folder or sent to a monitored e-mail address. The
XML file can contain document properties used to classify the
document when captured. The target catalog and document type
can also be defined in the XML file. For more information on
the XML descriptor, visit http://www.ademero.com/XmlSchemas/
ContentCentral/XmlCaptureDescriptor/.

2.5. Coding Methods
Pre-Capture Coding Users select a catalog and document type and provide document

properties before the capture process. Content Central automatically
converts and routes these documents to their storage areas without
the need for further user intervention.

Post-Capture Coding Users designate the catalog, document type, and document properties
after the capture process. Content Central routes these documents
to the user's Coding Queue where they await catalog and document
type selection and document properties coding. After a user codes a
document in the Coding Queue, the document is routed to the storage
area. Users who capture with this method will find the documents in

http://www.ademero.com/XmlSchemas/ContentCentral/XmlCaptureDescriptor/
http://www.ademero.com/XmlSchemas/ContentCentral/XmlCaptureDescriptor/
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their personal Coding Queue. The nature of a Post-Capture Coding
QCard™ allows the user to reuse the same QCard™.

Versatile Coding Users select a catalog, document type and Coding Queue Destination
to which the document should be sent, and are given the option to
provide document properties before and/or after capture. Documents
will be routed to the Coding Queue for review and additional
document properties before being routed to the storage area.

OCR Only / Capture Only Users select a catalog and document type before capture, but
document properties will not be added to these documents. Only
the OCR process (images) or capture process (electronic) will be
performed, and each document will be routed to its storage area using
the filename from the original image or electronic file.
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Chapter 1. Introduction
In this chapter you will become familiar with the user interface of Content Central and gain an
understanding of the basic procedures and abilities you will have. It's a good idea to read through the entire
User Guide; however, if you will only be designated to a single operation, such as Document Capture,
then you may wish to read only the section that pertains to you.

1. User Interface
To access Content Central you will need to launch your preferred Web browser and enter the URL (address)
provided by your administrator. Once you've successfully accessed Content Central, you will need to
provide your Username and Password (you should have received from your administrator) to login to
the system.

If you would like to prevent having to log in each time, select the Keep me logged in check box.

Note

This option may not be available in all configurations. Selecting the Logout button on the main
menu will require you to log in again.

Logging In to Content Central

2. The Main Menu
The main menu is always located at the top of Content Central. From the main menu you can access the
Search, Folders, and Capture areas. You can also Search All Catalogs, access your Options, Logout of
Content Central, and get Help. Administrators can access the administration menu with the Admin button.

3. The Dashboard
The Dashboard displays your most recent Messages, Approval Queue documents, Work Queue
documents, and Coding Queue documents. Clicking on any of these panels will take you to that specific
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area in Content Central. Access the Dashboard at any time by selecting the logo located in the far-left
area of the main menu.

The Dashboard

4. The Results Grid
The results grid displays information about documents and other content in the right frame (the Results
Frame) below the main menu.

Each row in the grid contains a checkbox at the beginning of the row. These checkboxes may be selected
to perform document actions on multiple documents at once. Use the Check menu to check All, check
None, or Invert the value of each checkbox.

Next to each checkbox is a status icon. This icon displays the Approval-Queue, Work-Queue, or Check-
Out status of each document in most results grids as defined below:

 Document is in your approval queue.
 Document is on one or more approval processes.
 Document is in your work queue.
 Document is in one or more work queues.
 Document is available for check out.
 Document is currently checked out by another user.
 Document is currently checked out by you.
 Your permissions do not allow you to check out this document.

For icons displayed in the Messages folder, see Chapter 5, The Messages Folder. For icons displayed in
the Approval Queue, see Section 17, “The Approval Queue [Enterprise Edition]”. For icons displayed in
the Coding-Queue, see Section 8, “The Coding Queue”.

Other features of the grid may be useful to you:

Column Sorting To sort the grid either ascending or descending based on the data in any
particular column, click the header for that column (the cell containing the
field name). Click it again to alternate the sort direction (ascending vs.
descending). The column sorted, as well as the direction sorted, is indicated
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on the grid header with the  and  icons. To remove sorting, select the
Remove Sorting link next to the menu bar.

Field Grouping You may group the results by one of the columns for a different view of
your results. Click and hold the column header you would like to group by,
and drag it into the area above the header with the message, "Drag a column
header here to group by that column". To revert to the original results view,
click and hold the column header again and drag it back into the results grid.

Column Arrangement You can rearrange the order of the columns in the grid by clicking and
holding a column header then moving it to the left or right until two red
arrows appear. The new order will be saved for future results.

Column Resizing You can resize columns in most grids by clicking and holding a column-
header divider (the area between two column headers) followed by moving
it to the left or right.

Refresh Select the  icon to refresh the grid at any time.

Export to Excel The information contained within the grid can be exported to Microsoft®
Excel® by selecting the  icon in the upper-right portion of the results-grid
frame.

5. User Options
The Options screen lets you update many settings specific to your user account. Access it by selecting

the  button on the main menu.

The Options Screen

5.1. User Profile

You may update your profile information by selecting the  icon in the Options screen. You can
change your name, e-mail address, and password depending on your security level.
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User Profile

5.2. Preferences

There are several system preferences you can configure by selecting the  icon in the Options screen.
The following list explains each of the preferences.

Language Select the language that you prefer to use while navigating the
application. Default uses the language setting configured in your
Web browser.

Default Capture Catalog This selection determines the default Catalog selection when
accessing the Capture area.

Automatically open the first
document in any results grid.

When selected, the first document in a results grid will be opened.

Require a double-click to open a
document.

By default, a single click on any results-grid row will open the
document. This preference will require a double click to open a
document.

Refresh grid when changing
document properties.

Enabling this feature will cause any list of results to immediately
update after document properties have been committed.

Disable PDF Streaming This option appears when administrators have enabled PDF
streaming. Select this checkbox if you wish to disable PDF
streaming for your personal account.

Send a copy of each Content
Central message to the e-mail
address defined in my User Profile.

When selected, a copy of each Content Central message will be sent
to your e-mail address.

Notify me when a new document
arrives in my Approval Queue.
[Enterprise Edition]

When selected, a message will be sent to you every time a document
lands in your Approval Queue.
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Notify me when a new document
arrives in my Work Queue.
[Enterprise Edition]

When selected, a message will be sent to you every time a document
lands in your Work Queue.

Notify me when a document arrives
in my Coding Queue due to Zonal
OCR processing. [Enterprise
Edition]

When selected, a message will be sent to you when a document
lands in your Coding Queue because of a potential problem with
Zonal OCR processing.

Notify me when a document
cannot be processed by the Capture
Service. [Administrators]

When selected, a message will be sent to you when a document
cannot be captured.

Automatically print QCards™. When selected, Content Central will launch the print dialog in

your PDF viewer when you select the  button to produce a
QCard™.

Use default printer without
prompting.

If the previous and current selections are enabled, the print dialog
will be bypassed, and your default printer will receive the print
job containing the QCards™. Your PDF viewer may require a
confirmation for security reasons.

User Preferences

5.3. Downloads and Installers

Select the  icon in the Options screen to download and/or install helper applications.

Install Content Central Search
Provider

Select this link to install Content Central as one of the search
providers in your Web browser. With this feature installed, you
will be able to use your Web browser's Search function to search
for information within Content Central. Your query will be used to
search all catalogs where you have the search permission.

Download Content Central Content
Director

Select this link to install the Content Director application on
your local desktop computer. This application allows you to edit
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documents directly from the Content Central browser interface.
Saving a document upon exiting its native application will
automatically upload it to the Content Central server. For more
information see Section 9, “Editing Documents”.

Downloads and Installers

5.4. Address Book

Select the  icon in the Options screen to access your personal Address Book.

Contacts in your address book can be used when sending documents via e-mail or fax or sharing documents.
Records are stored unique by Contact Name.

Address Book
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5.4.1. Adding or Modifying a Contact

To modify an existing contact, double click the row you would like to modify, make changes, and click
off the row to save the changes.

To add a new contact, double click the last row displayed on the current page. You must provide a valid
Contact Name for each record. All additional columns are optional. When you have finished adding a

record, click off the row or select the  button to return to the Options screen.

You can upload a comma-delimited text file containing a list of contacts by selecting the  button,

browsing to the file, and selecting the  button to process the file. Do not include a header record.
Duplicate contacts will be discarded. The required format for the file is as follows:

Contact Name (required),Company Name (optional),E-mail Address (optional),Fax Number (optional)

5.4.2. Deleting One or More Contacts

To remove one or more contacts from your address book, select the checkbox in the row or rows you

would like to delete from the current page, and select the  button.

5.5. Saved Searches

Manage your saved searches by selecting the  icon in the Options screen.

To automatically perform a search when a saved search has been selected from the Search area, select

Auto-execute searches upon selection. Select the  button to apply your changes and return to
the Options screen.

Saved Searches

5.5.1. Modifying a Saved Search

To modify a search query, select the  icon in the appropriate row. Here you can edit the Title, determine
whether the query will be Enabled and available for searching, and select whether the query will be
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available for other users by making it Public. Select the  button when you have finished modifying
the query.

5.5.2. Deleting a Saved Search

To delete a search query, select the  icon in the appropriate row, followed by selecting the  button
to permanently delete the saved search.

5.6. Default Document Types

Choose your Default Document Types for each catalog by selecting the  icon in the Options screen.
A default document type is used for the following:

• Determines the document type of one or more uploaded files when using the results-grid drag-and-drop
tool in the Catalog Browser.

• Determines the document type used when pasting one or more documents in the Catalog Browser.

• Appears first in document-type drop-down lists in the Capture frame and in the Drag & Drop Upload
applet.

When you have finished selecting a default document type for a catalog, select the  button to save

the changes. Select the  button to return to the Options screen.

Default Document Types

5.7. Search Fields

You may pick the fields you wish to use during a search by selecting the  icon in the Options screen.

Select the catalog and document type that you would like to manage.

Use the  icon to add fields from the Available Fields box to the Search Fields box.
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Use the  and  icons to change the order that the fields will appear on the screen.

The administrator may have defined a default set of fields that you can remove, if desired, using the  icon.

Tip

Select Add Capture/Edit Fields below the Search Fields box to save time and add the fields
designated as capture fields.

When you have finished selecting fields for a document type, select the  button to save the changes.

Select the  button to return to the Options screen.

User Search Fields

5.8. PIN

Define your personal identification number by selecting the  icon in the Options screen.

Your PIN will be needed when approving or rejecting documents. For more information, see Section 17.1,
“Approving”.

When you have finished adding or modifying your PIN, select the  button to save the changes.

Select the  button to return to the Options screen.

5.9. DocType Results Fields

You may pick the document-type fields you wish to see in the results grid by selecting the  icon
in the Options screen.

Select the catalog and document type that you would like to manage.

Use the  icon to add fields from the Available Fields box to the Results Fields box.
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Use the  and  icons to change the order that the fields will appear in the grid.

The administrator may have defined a default set of fields that you can remove, if desired, using the  icon.

Tip

Select Add Search Fields below the Results Fields box to save time and add the fields from the
Search Fields option.

When you have finished selecting fields for a document type, select the  button to save the changes.

Select the  button to return to the Options screen.

User Results Fields

5.10. Grid Results Fields

You may pick the grid-specific fields and system fields you wish to see in each results grid by selecting

the second  icon in the Options screen.

Each grid type can have its own unique set of fields displayed as columns. Select the type of grid you
would like to configure by selecting it from the drop-down list under the Grid-Specific Fields label.

Use the  icon to add fields from the Grid-Specific Fields and System Fields boxes to the Results Fields
box.

Use the  and  icons to change the order that the fields will appear in the grid.

When you have finished selecting fields for a grid type, select the  button to save the changes.

Select the  button to return to the Options screen.
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User Grid-Results Fields

5.11. Event Viewer

The event viewer allows you to track actions that you have performed while logged in to Content Central.

The event log also maintains records of documents that you have captured. Access it by selecting the 
icon from the Options screen.

You may filter your view by selecting any combination of options from the drop-down list above the log

table. Select the  button to update the log table after you've chosen your filters. Use the paging bar
below the log table to view additional pages of log entries.

Select the  button to return to the Options screen.

Event Viewer
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6. Getting Help

If you get stuck or need to reference this documentation at any time, select the  button at the top
of the current dialog.
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Chapter 2. Capturing Documents
This chapter will teach you how to capture both paper documents (from a scanning device) and electronic
documents. If you haven't read the introductory sections, Capture Types and Coding Methods, you should
do that now.

Access the Capture frame by selecting the  button from the main menu.

1. Capturing Paper Documents - DirectScan™
The DirectScan applet allows you to capture paper documents from a scanning device connected to your
computer. The following describes each of the coding methods available when capturing with DirectScan.

1.1. Pre-Capture Coding
Use this method of capture when you wish to capture a paper document and provide the document
properties for that document before scanning.

1. Select the DirectScan Capture Type.

2. Select the Pre-capture coding Coding Method.

3. Select a catalog and document type to add the document to.

4. Enter information about the document into the appropriate field text boxes. If any key icons are
displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field
lookup. One or more of the fields will be updated.

5. Optional: You can scan several documents with the same number of pages by selecting the Fixed Page
Count checkbox and providing a number of pgs per document.

6. Select the  button to launch the DirectScan applet.

7. Scan the document as described in Section 1.5, “Using The DirectScan™ Applet”.
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Pre-Capture Coding with DirectScan

1.2. Post-Capture Coding
Use this method of capture when you wish to capture a paper document and provide the document
properties for that document after scanning. Several documents may be scanned together when using the
Fixed Page Count option as long as each document in the batch consists of the number of pages specified.

1. Select the DirectScan Capture Type.

2. Select the Post-capture coding Coding Method.

3. Select a catalog and document type to add the document to.

4. Optional: You can scan several documents with the same number of pages by selecting the Fixed Page
Count checkbox and providing a number of pgs per document.

5. Select the  button to launch the DirectScan applet.

6. Scan the document as described in Section 1.5, “Using The DirectScan™ Applet”.

Post-Capture Coding with DirectScan

1.3. Versatile Coding
Use this method of capture when you wish to capture a paper document and provide the document
properties for that document before scanning, after scanning, or at both times. Several documents may be
scanned together when using the Fixed Page Count option as long as each document in the batch consists
of the number of pages specified.

1. Select the DirectScan Capture Type.

2. Select the Versatile coding Coding Method.

3. Select a catalog and document type to add the document to.

4. Choose whether you want this document to be sent to your Personal Queue or the Shared Queue.
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Note

The Personal Queue is visible to you only. The Shared Queue is visible to you and others with
permission to add documents for the selected document type.

5. Enter information about the document into the appropriate field text boxes. If any key icons are
displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field
lookup. One or more of the fields will be updated.

6. Optional: You can scan several documents with the same number of pages by selecting the Fixed Page
Count checkbox and providing a number of pgs per document.

7. Select the  button to launch the DirectScan applet.

8. Scan the document as described in Section 1.5, “Using The DirectScan™ Applet”.

Versatile Coding with DirectScan

1.4. OCR Only
Use this method of capture when you wish to capture only the (typed) full-text of a document. Several
documents may be scanned together when using the Fixed Page Count option as long as each document
in the batch consists of the number of pages specified.

1. Select the DirectScan Capture Type.

2. Select the OCR only Coding Method.

3. Select a catalog and document type to add the documents to.

4. Optional: You can scan several documents with the same number of pages by selecting the Fixed Page
Count checkbox and providing a number of pgs per document.

5. Select the  button to launch the DirectScan applet.
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6. Scan the document as described in Section 1.5, “Using The DirectScan™ Applet”.

OCR-only Coding with DirectScan

1.5. Using The DirectScan™ Applet

This Java® applet allows you to capture paper documents with a TWAIN-compliant scanner connected to

your computer. Once you've selected the  button from within the Capture frame, the DirectScan™
applet will launch in the right frame of Content Central. You may be asked to allow the applet to launch
from within your browser. This is normal behavior. Once the applet has launched, perform the following
steps:

1. Select the appropriate scanning device from the Scanner list.

2. Place the documents in your scanner's document feeder.

3. Optional If you would like to bypass your scanner's software dialog, select the Hide Scan Dialog

checkbox and then select the  button to choose the scan settings.

4. Select the  button.

5. Choose the appropriate settings and options (if any) for your scanner and initiate the scanning process.
When the scanner has completed, the images will appear in the DirectScan™ applet.

6. Review the scanned images (see Section 1.5.1, “Image Reviewing Tools”). Use the horizontal scroll
bar at the bottom of the image-preview frame to view images outside of the viewing area. Images will

be grouped in sets of 25. To move from one group of images to another, select the  or 

buttons. If you wish to rescan the images, select the  button and repeat steps 2 through 4.

7. Once you are satisfied with the scanned images, select the  button. The images will be uploaded
to the Content Central server. The bar to the left of the button will indicate progress of the upload
process.
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The DirectScan™ Applet

1.5.1. Image Reviewing Tools

The following tools, located above the image-preview frame, can be used to assist with the quality
assurance process

Increases the visible dimensions of all images in the current image set

Decreases the visible dimensions of all images in the current image set

Rotates the selected image(s) 90 degrees clockwise

Moves the selected image before the previous image

Moves the selected image after the next image

Deletes the selected image(s) from the current image set

2. Capturing Paper Documents - QCards™
The following describes each of the coding methods available when capturing paper documents with
QCards™.

2.1. Pre-Capture Coding
Use this method of capture when you wish to capture a paper document and provide the document
properties for that document before scanning.

1. Select the QCard Capture Type.
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2. Select the Pre-capture coding Coding Method.

3. Select a catalog and document type to add the document to.

4. Enter information about the document into the appropriate field text boxes. If any key icons are
displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field
lookup. One or more of the fields will be updated.

5. Optional: You can make this a Fixed Page Count QCard™ by selecting the checkbox and providing
a number of pgs per document.

6. Optional: You can allow field values for the documents to be obtained from an External Data Source
when captured by selecting the Perform key-field lookup at capture time checkbox. The key field
must be available on the QCard™.

7. Optional: You can include an End-of-Document QCard™ by selecting the checkbox.

8. Select the  button to generate the QCard™.

9. Print the QCard™.

10.Place the QCard™ on top of the document to be scanned. Place the optional End-of-Document QCard™
at the end of the document.

11.Scan the documents using your scanning device.

A Pre-Capture Coding QCard™
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An Included End-of-Document QCard™

2.2. Post-Capture Coding

Use this method of capture when you wish to capture a paper document and provide the document
properties for that document after scanning. This QCard™ may be used as a Fixed Page Count QCard™
allowing you to scan multiple documents in with only one QCard™ as long as each document consists
of the number of pages specified.

1. Select the QCard Capture Type.

2. Select the Post-capture coding Coding Method.

3. Optional: You can make this a Fixed Page Count QCard™ by selecting the checkbox and providing
a number of pgs per document.

4. Optional: You can allow field values for the documents to be obtained from an External Data Source
when captured by selecting the Perform key-field lookup at capture time checkbox. The key field
must be available on the QCard™.

5. Optional: You can include an End-of-Document QCard™ by selecting the checkbox.

6. Select the  button to generate the QCard™.

7. Print the QCard™.

8. Place the QCard™ on top of the [first] document to be scanned. Place the optional End-of-Document
QCard™ at the end of the last document.

9. Scan the documents using your scanning device.
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A Post-Capture Coding QCard™

2.3. Versatile Coding
Use this method of capture when you wish to capture a paper document and provide the document
properties for that document before scanning, after scanning, or at both times. This QCard™ may be used
as a Fixed Page Count QCard™ allowing you to scan multiple documents in with only one QCard™ as
long as each document consists of the number of pages specified.

1. Select the QCard Capture Type.

2. Select the Versatile coding Coding Method.

3. Select a catalog and document type to add the documents to.

4. Choose whether you want this document to be sent to your Personal Queue or the Shared Queue.

Note

The Personal Queue is visible to you only. The Shared Queue is visible to you and others with
permission to add documents for the selected document type.

5. Enter information about the document into the appropriate field text boxes. If any key icons are
displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field
lookup. One or more of the fields will be updated.

6. Optional: You can make this a Fixed Page Count QCard™ by selecting the checkbox and providing
a number of pgs per document.

7. Optional: You can allow field values for the documents to be obtained from an External Data Source
when captured by selecting the Perform key-field lookup at capture time checkbox. The key field
must be available on the QCard™.

8. Optional: You can include an End-of-Document QCard™ by selecting the checkbox.

9. Select the  button to generate the QCard™.
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10.Print the QCard™.

11.Place the QCard™ on top of the [first] document to be scanned. Place the optional End-of-Document
QCard™ at the end of the last document.

12.Scan the documents using your scanning device.

A Versatile Coding QCard™

2.4. OCR Only
Use this method of capture when you wish to capture only the (typed) full-text of a document. This
QCard™ may be used as a Fixed Page Count QCard™ allowing you to scan multiple documents in with
only one QCard™ as long as each document consists of the number of pages specified.

1. Select the QCard Capture Type.

2. Select the OCR only Coding Method.

3. Select a catalog and document type to add the documents to.

4. Optional: You can make this a Fixed Page Count QCard™ by selecting the checkbox and providing
a number of pgs per document.

5. Optional: You can allow field values for the documents to be obtained from an External Data Source
when captured by selecting the Perform key-field lookup at capture time checkbox. The key field
must be available on the QCard™.

6. Optional: You can include an End-of-Document QCard™ by selecting the checkbox.

7. Select the  button to generate the QCard™.

8. Print the QCard™.

9. Place the QCard™ on top of the [first] document to be scanned. Place the optional End-of-Document
QCard™ at the end of the last document.

10.Scan the documents using your scanning device.
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An OCR Only QCard™

3. Capturing Paper Documents - Document-
Type QCard™

Document-Type QCards™ can be printed and used to change the document type within a batch of paper
documents sharing the same document properties.

Note

A Document-Type QCard™ can be used more than once and is compatible with any coding method.

Example 2.1. Document-Type QCard™ Example

A user creates a Pre-capture coding QCard™ for the primary (first) document type in the batch to be
scanned. This QCard™ specifies document properties for all documents in the batch to be scanned.

A Document-Type QCard™ is printed for every additional document type in the batch. These QCards™
are placed in front of the document they represent.

The user scans the batch of documents. The Capture Service splits the batch into individual PDF documents
based on the document type represented by each QCard™, and all documents receive the document
properties represented by the Pre-capture coding QCard™.

3.1. Creating a Document-Type QCard™
1. Select the Document-Type QCard Capture Type.

2. Select a catalog and document type.

3. Select the  button to generate the QCard™.

4. Print the QCard™.

5. Place the QCard™ on top of its document to be scanned.
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6. Assemble the batch of documents, making sure the first QCard™ for the batch is a regular QCard™,
and scan the documents using your scanning device.

A Document-Type QCard™

4. Capturing Paper Documents - QCard™
Packet

QCard™ Packets are based on packet templates defined by your administrator. This capture type allows
you to produce multiple QCards™ in one step.

4.1. Creating a QCard™ Packet
Use this method of capture when you wish to capture a packet of paper documents.

1. Select the QCard Packet Capture Type.

2. Select the Packet template.

3. Enter information about the documents into the field text boxes. Only the fields shared among all the
document types in the packet template will be visible. If any key icons are displayed next to a field,
you may select the Perform key-field lookup link to perform a real-time field lookup. One or more
of the fields will be updated.

4. Optional: You can allow field values for the documents to be obtained from an External Data Source
when captured by selecting the Perform key-field lookup at capture time checkbox. The key field(s)
must be available on the QCards™.

5. Optional: You can include one End-of-Document QCard™ at the end of the packet by selecting the
checkbox.

6. Select the  button to generate the packet of QCards™.

7. Print the QCards™.

8. Place each QCard™ on top of its document to be scanned. Place the optional End-of-Document
QCard™ at the end of the packet.
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9. Scan the documents using your scanning device.

A QCard™ Packet

5. Capturing Paper Documents - Custom
Barcode

You can scan documents containing custom barcodes with the Custom Barcode Capture Type, utilizing
the DirectScan™ applet.

1. Select the Custom Barcode Capture Type.

2. Select a catalog and document type to add the document to.

3. Select the  button to launch the DirectScan applet.

4. Scan the document as described in Section 1.5, “Using The DirectScan™ Applet”.
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Capturing with Custom Barcodes

6. Capturing Electronic Documents
If you would like to capture documents and/or other files that you have local access to, you may use these
features to import those documents or files into Content Central. Single files can be uploaded using the
Capture frame, and multiple files can be uploaded using the Drag & Drop Upload applet in the Catalog
Browser.

6.1. Using the Capture Frame
Files can be individually uploaded using the Electronic Capture Type in the Capture frame. The
following sections describe the various Coding Methods available when uploading documents.

Note

When uploading an existing PDF document, you will be presented with three upload options before
the document is committed to the catalog.

Capture file in original form The document will be left as-is and committed to the catalog
with the document properties supplied. If the document
does not already contain OCR text for full-text searching,
the only information that will be searchable will be the
document properties.

Convert to a fully-searchable PDF The document will be converted to a new PDF containing
document properties and OCR for full-text searches.

Make fully-searchable, but leave
file in original form

Images will be processed for OCR text, but the file will
remain in its original format. The OCR and document
properties will be stored only in the Content Central
database.

The document may be viewed in the area below these options by selecting the View Document

link. After choosing an upload option, select the  button to complete the upload process.

PDF Upload Options
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6.1.1. Pre-Capture Coding

Use this method of capture when you wish to capture an electronic document and provide the document
properties for that document before uploading.

1. Select the Electronic Capture Type.

2. Select the Pre-capture coding Coding Method.

3. Select a catalog and document type to add the document to.

4. Enter information about the document into the appropriate field text boxes. If any key icons are
displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field
lookup. One or more of the fields will be updated.

5. Browse to the location of the local file.

Browsing for an Electronic File

6. Select the  button to begin the upload process.

Capturing an Electronic File with Pre-Capture Coding
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6.1.2. Post-Capture Coding

Use this method of capture when you wish to capture an electronic document and provide the document
properties for that document after uploading.

1. Select the Electronic Capture Type.

2. Select the Post-capture coding Coding Method.

3. Select a catalog and document type to add the document to.

4. Browse to the location of the local file.

5. Select the  button to begin the upload process.

Capturing an Electronic File with Post-Capture Coding

6.1.3. Versatile Coding

Use this method of capture when you wish to capture an electronic document and provide the document
properties for that document before uploading, after uploading, or at both times.

1. Select the Electronic Capture Type.

2. Select the Versatile coding Coding Method.

3. Select a catalog and document type to add the document to.

4. Choose whether you want this document to be sent to your Personal Queue or the Shared Queue.

Note

The Personal Queue is visible to you only. The Shared Queue is visible to you and others with
permission to add documents for the selected document type.

5. Enter information about the document into the appropriate field text boxes. If any key icons are
displayed next to a field, you may select the Perform key-field lookup link to perform a real-time field
lookup. One or more of the fields will be updated.
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6. Browse to the location of the local file.

7. Select the  button to begin the upload process.

Capturing an Electronic File with Versatile Coding

6.1.4. Capture Only

Use this method of capture when you wish to capture an electronic document without providing any
document properties.

1. Select the Electronic Capture Type.

2. Select the Capture only coding Coding Method.

3. Select a catalog and document type to add the document to.

4. Browse to the location of the local file.

5. Select the  button to begin the upload process.
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Capturing an Electronic File As Is

6.2. Using the Drag & Drop Upload Applets
Documents and other content can be uploaded in three different ways using the Catalog Browser. To

access the Catalog Browser, select the  button from the main menu followed by the  icon in
the left frame. Next, select a folder to upload one or more documents into. The following sections describe
how to upload documents and other content inside the Catalog Browser.

Selecting a Folder to Upload Documents in the Catalog Browser

6.2.1. Using the Context Menu or File Menu

Any folder in the Catalog Browser tree can be right-clicked to produce a context menu containing the
Add Documents(s) menu item. This same menu item can be accessed from the File menu in the Results
Frame. After selecting this menu item, the Drag & Drop Upload applet will appear in a new window.

The Catalog Browser Context Menu
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Files can be queued for upload in two ways. Selecting the  button will provide you with a browse
dialog used to choose one or more files you have local access to.

Select the appropriate Document Type from the drop-down list.

You can also drag folders and files from your computer desktop or a system file explorer and drop them
into the area labeled Drop Files Here.

Use the  button to remove one or more files from the queue.

After queuing one or more files or folders, select the  button to upload the files to the Content

Central server. Select the  button to cancel the upload.

The Drag & Drop Upload Dialog

6.2.2. Using the Results-Frame Upload Area

One or more folders or files can be dragged from your computer desktop or system file explorer and
dropped into the area of the Results Frame labeled Drop files here to upload.

The upload process will begin immediately after files have been dropped into the designated area. Select
the  icon to cancel the upload.

Note

The default document type chosen for the catalog will be used to identify the uploaded documents.
For more information, see Section 5.6, “Default Document Types”.
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Dragging Files Into the Results Frame

7. Creating New Documents From PDF-Form
Templates

Use this capture type when you want to generate a new document from a PDF-Form template.

1. Select the Form Capture Type.

2. Select a catalog and document type to add the document to.

3. Enter information about the document into the appropriate field text boxes.

4. Select the  button to load the form.

5. Fill out the form as required.

6. Select the proper submission button in the form to complete the process.
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Creating New Documents using a PDF Form

A new document will be created and stored in the selected catalog immediately after submitting the form.
When accessed inside Content Central, this new document can be modified and re-submitted to generate
a new version of the document automatically.

8. The Coding Queue
Any documents that have been captured using Post-Capture coding or Versatile coding must be fully
coded before they will be routed to their appropriate storage area. The Coding Queue in your Folders
frame holds these documents for you to code.

Two types of documents can exist within the Coding Queue. Personal documents are identified by the 
icon and shared documents are identified by the  icon.

Personal Documents Documents captured using the Post-capture coding method and documents
captured using the Versatile coding method with a Personal Queue
destination will become personal documents. These documents will only
appear to the user who captured the documents.

Shared Documents Documents captured using the Versatile coding method with a Shared Queue
destination will become shared documents. These documents will appear
to all users who have permission to add documents for the document type
selected during the capture process.

Access the Folders frame by selecting the  button from the main menu. Select the  icon in the
Folders frame to obtain the list of documents awaiting the coding process.

The Coding Queue

To begin coding these documents, select the Code Document(s) menu item from the Modify menu. The
Document Properties frame will appear on the right side of your browser. Select the catalog and document

type, enter appropriate information for any fields listed, then select the  button to save changes to

the properties and route the document from the queue to the catalog, or select the  button to save
changes and leave the document in the Coding Queue. When committing the document to the catalog,
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Content Central will route the file to the appropriate storage area, and the next document in the results
grid will load for coding.

If any key icons are displayed next to a field, you may select the Perform key-field lookup link to perform
a real-time field lookup. One or more of the fields will be updated.

If a Use Filing Rules checkbox is presented, you may choose whether or not the field information will
cause the file name to change.

Coding Documents in the Coding Queue
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Chapter 3. Searching for Documents

1. Search Procedures
A very common operation for users of a document management system is searching for documents. Search
queries are performed in the left frame, results will be displayed in the upper-right frame, and documents
will be displayed in the lower-right frame (for document formats having browser plugins).

The Search Frame

Performing a search is as simple as selecting one or more catalogs and document types, entering criteria in

one or more field search textboxes, and selecting the  button. Some search boxes contain predefined
choices that you can select from a list. The most efficient searches result from searching document
properties such as Name or Number. These searches will narrow your results down considerably.

You can instead choose to select an existing query from the Saved Searches drop-down list, if available.
The saved query will be entered automatically, and the search will be performed automatically if the
appropriate option has been enabled. For more information, see Section 5.5, “Saved Searches”.
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A Document properties Search

You may also search for documents using full-text information. This can be used as the only method to
search, or it can be combined with document properties. When searching for full text, every occurrence
of the word or phrase you use to search will be highlighted when retrieving PDF documents. For more
information on full-text searching, see Appendix B, Advanced Search Syntax.

A Full-Text and Document properties Search

To search all versions of documents that match your search criteria, select the Search all versions
checkbox.
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Searching All Versions

To save your search query, select the Save this search checkbox, provide a Saved-Search Title, and

select the  button. You can manage these saved searches from your options. See Section 5.5, “Saved
Searches”.

2. Searching by Packet
If one or more packet templates have been defined in the system, you will see a checkbox at the top of the
search frame named, Search by Packet. Selecting this checkbox will present you with one or more packet
templates you can search on. The key field will be displayed depending upon the packet template selected.

Enter the key-field value you are searching for, and select the  button to perform the search. All
of the documents in the packet will be returned.

3. QuickSearch
The QuickSearch box in the right-center area of the main menu can be accessed from any location in
Content Central. Enter your query in the QuickSearch box and the information provided will be used to
search all document types where you have the search permission.

4. Saving Search Results
You may export the full list of search results, which may extend beyond the number of results displayed
in the results grid, by selecting the Save Results menu item from the File menu. The data will be exported
to an XML file based on the columns visible in the results grid. You will be provided with a dialog box
to Open or Save the file to your local machine. Two fields, DocFilename and DocPath, will be included
with each result, referencing the real filename and path to the document.
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The Open/Save Dialog for Search Results
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Chapter 4. Managing Documents
1. Introduction

Documents can be retrieved and managed in several ways using the File, Edit, Modify, View, and
Approval Queue menus at the top of the results-grid frame. Some of these menus may not always be
available.

The File Menu

2. Viewing a Document in the Browser
The default behavior when selecting a row in the results grid is to open the associated document in the
preview area below the results grid. To change this behavior, see Section 5.2, “Preferences”.

A PDF Document Viewed in the Web Browser
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3. Streaming a PDF Document
If your administrator has enabled PDF Streaming, only the first page of PDF files will be sent to the
preview area. The top of the image will include a watermark indicating PDF Streaming Enabled and the
page number(s) that you are viewing from the original.

To view other pages, select one of the menu items from the PDF Streaming menu located above the
results grid. You can move forward and backward and also select a specific range of pages to view. To
download the original file in the preview area, select Show Full-Page Original from the menu.

Streaming a PDF Document

4. Downloading Documents
When a browser plugin doesn't exist for the document you've retrieved, you will be provided with a dialog
box to Open or Save the document to your local machine. You can also access this dialog by selecting
the Download menu item from the File menu.

The Open/Save Dialog for a Single Document

To save multiple documents, select the checkbox in each document row, and select the Zip & Save menu
item in the File menu.
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The Open/Save Dialog for Multiple Documents

5. E-mailing Documents
You may send one or more documents in the results grid to one or more e-mail recipients by selecting the
E-mail menu item from the File menu. When the E-mail Document(s) dialog appears, you may select an
available message template from the drop-down list in the top right of the dialog (if visible), or manually
add the recipient(s)' E-mail Address(es), a Subject line, and an optional Message.

Selecting the To: or CC: buttons will load your address book. Use this list of contacts to quickly add
recipients to your e-mails. After you have selected one or more recipients from the list, select the To: or

CC: buttons to queue the recipients. When you are satisfied with your selections, select the  button
to add them to your e-mail. For information on managing your address book, see Section 5.4, “Address
Book”.

When your e-mail is complete, select the  button. Recipients are automatically saved to your address
book when you send an e-mail.

Sending Documents via E-mail
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Address Book for E-mailing

6. Faxing Documents
You may send one or more documents in the results grid to one or more fax recipients by selecting the Fax
menu item from the File menu. When the Fax Document(s) dialog appears, you may select an available
message template from the drop-down list in the top right of the dialog (if visible), or manually add the
recipient(s)' Fax Number(s), an optional Recipient Name and Company, a Subject line, and some optional
Message Text.

Selecting the To: button will load your address book. Use this list of contacts to quickly add recipients to
your faxes. After you have selected one or more recipients from the list, select the To: button to queue the

recipients. When you are satisfied with your selections, select the  button to add them to your fax.
For information on managing your address book, see Section 5.4, “Address Book”.

Select the  button when finished. Recipients are automatically saved to your address book when
you send a fax.

Sending Documents via Fax
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Address Book for Faxing

7. Appending to a Document
To append additional pages to an existing document, you will need to first locate the document. When the
document is in your results grid, select the appropriate row and select the Append menu item from the
Modify menu. You can append to the document using DirectScan™, QCard™, or Electronic Upload by
selecting the appropriate menu item.

7.1. Appending by DirectScan™
The DirectScan™ applet will launch in a new window. Use this applet to append pages to the document
by scanning additional pages. For more information, see Section 1.5, “Using The DirectScan™ Applet”.

Appending using DirectScan™
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7.2. Appending by QCard™

A new window will appear containing an Append Document QCard™. Print this QCard™, place it on top
of the additional pages, and scan the document. Content Central will create a new version of the document
containing the pages from the most-recent version combined with the scanned pages.

An Append Document QCard™

7.3. Appending by Electronic Upload

When the Append window appears, Browse to the file containing the additional pages and select the

 button.

Appending using Electronic Upload

8. Replacing a Document
To replace the current version of an existing document, you will need to first locate the document. When
the document is in your results grid, select the appropriate row and select the Replace menu item from
the Modify menu. You can replace a document using DirectScan™, QCard™, or Electronic Upload by
selecting the appropriate menu item.
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8.1. Replacing by DirectScan™
The DirectScan™ applet will launch in a new window. Use this applet to replace the document by scanning
new pages. For more information, see Section 1.5, “Using The DirectScan™ Applet”.

Replacing using DirectScan™

8.2. Replacing by QCard™
A new window will appear containing a Replace Document QCard™. Print this QCard™, place it on top
of the new set of pages, and scan the document. Content Central will create a new version of the document
containing only the pages scanned.

A Replace Document QCard™
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8.3. Replacing by Electronic Upload

When the Replace window appears, Browse to the new file and select the  button.

Replacing using Electronic Upload

9. Editing Documents
Documents can be edited easily using native applications on your Microsoft® Windows® workstation.
This requires the Content Director application installed on your local computer.

Note

It's possible to edit documents without the Content Director by manually checking-out,
downloading, editing, and checking-in the documents. For more information, see Section 16,
“Checking Out/Checking In Documents”.

The Content Central Office Integration application can be installed on any workstation containing
Microsoft® Office® to further assist in the document capture and editing process within applications like
Word®, Excel®, and Outlook®.

Note

Both Content Director and Content Central Office Integration are client-side applications, and
each must be installed on user workstations where their functionality is desired.

9.1. Content Director
The Content Director is responsible for directing documents and other content between the Content Central
server and your local computer.

9.1.1. Installation
The installation package for the Content Director application can be accessed from the Options area by

selecting the  button on the main menu followed by selecting the  icon for Downloads and
Installers.

Note

The Content Director application runs on only the Microsoft® Windows® platform.
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Select Download Content Central Content Director to download and/or begin the installation package.
Follow the prompts to complete the installation.

The installation package will automatically configure your computer to launch the Content Director each
time your computer is started. This default behavior can be changed in the settings dialog.

9.1.2. Settings

You can access the settings of the Content Director by locating the icon in the system tray of your
Windows® application bar and right-clicking it followed by selecting the Settings menu item.

The Content Director Settings Dialog

The Local Document Folder points to a location on your local computer that will temporarily store
documents while they are being edited. When an edited document has been uploaded to the server, the
Content Director will automatically remove it from this location.

The Port setting determines the local Windows® port that will be used for communication to and from
the server.

You may select the checkbox labeled Do not show informational balloon tips if you do not wish to see
notices of downloads and uploads. You may also choose whether the application will automatically Check
for updates and Run at Windows startup.

When you have finished making changes, select the OK button to close the settings dialog.

9.2. Content Central Office Integration

The Content Central Office Integration application (CCOI) integrates with your implementation of
Office® 2003, 2007, 2010 32-bit, or 2010 64-bit in the form of a custom toolbar that communicates with
the Content Central server.
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CCOI in Word® 2003

9.2.1. Settings

You can access CCOI settings by clicking the Settings button on the CCOI toolbar within your Office®
application. This should be accessed the first time CCOI is used.

Service Locations CCOI connects to the Content Central server using Web services. The service
locations can be entered in one of two ways.

Auto Discover Service URLs In most cases, you can provide the
URL to Content Central (example:
http://servername/ContentCentral) and
CCOI will automatically determine the
service locations.

Manually Configure Services The services may need to be entered
manually if the server configuration
has been customized.

Select the Test Services button to verify the service locations entered are valid.

Log in You must provide your Content Central login information for CCOI to
authenticate with the Content Central server. Select the Test Log In button
to verify these entries.

You may select the checkbox labeled Notify when working on Read Only files if you wish to see
notices when opening a document that cannot be edited. You may also choose whether the application
will Use temporary folder for new and read only files. When this option is checked, the application
will automatically save new documents to a temporary folder prior to uploading them to Content Central.
These files will be automatically deleted when the application is closed.

When you have finished making changes, select the Save Settings button to save the settings and close
the dialog.
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CCOI Settings Dialog

9.2.2. Capturing New Documents

You can capture any Office® document that has not been previously captured by selecting the Capture
New button on the toolbar. The Check-In dialog will launch, allowing you to choose the appropriate
destination and document properties for the document.

Note

To capture e-mails using Outlook®, select the Capture emails to Content Central menu item
from the Content Central menu.

Destination This selection determines whether the document will be sent
directly to a Catalog or to the Coding Queue for review.

Catalog The document will be routed
to the selected Catalog. Any
required document properties
must be provided before you
can Upload. These document
properties are indicated with
bold text.

Personal Coding Queue The document will be routed to
the Coding Queue, visible only
to you.

Shared Coding Queue The document will be routed to
the Coding Queue, visible to you
and others with permission to
add documents for the document
type selected.

Catalog and Document Type Select an appropriate Catalog and Document Type for the
document. These selections can be changed later in the Coding
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Queue when the Destination is set to Personal Coding Queue or
Shared Coding Queue.

Document Properties Enter appropriate document properties for the document. Any
required fields are indicated with bold text. All fields are optional
when the Destination is set to Personal Coding Queue or Shared
Coding Queue.

When all selections have been made, select the Upload button to route the document to the Content Central
server. You will be prompted to save the file locally if it has not been saved and you have not chosen to
use a temporary folder (see Section 9.2.1, “Settings”).

CCOI Check-In Dialog

9.2.3. Checking Out a Local Document

If you've loaded an Office® document outside of the Content Central Web application and the document
has been previously added to Content Central, you can check out the document by selecting the Check
Out button on the CCOI toolbar. This will notify other users in Content Central that you are editing the
document.

9.3. Editing a Document

To edit a document, select the results-grid row of a document to modify followed by the Edit Document
menu item from the Modify menu. The document will be checked-out from the system automatically
and routed to your local machine via the Content Director. Once the file has been downloaded, its native
application will launch and load the document.

After modifications have been completed, the document needs to be uploaded to the document server.

9.4. Uploading Changes using CCOI

Use this method of uploading if your document is a Microsoft® Office® document and you have installed
CCOI.

After making necessary changes to the document, select the Update Document button on the CCOI
toolbar. The new version will be uploaded, and the document will be checked in if previously checked out.
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9.5. Uploading Changes without using CCOI

After making necessary changes to the document, close the application, making sure to choose Yes when
asked if you would like to save the changes. The Content Director will provide a dialog allowing you to
choose your preferred action.

Select the appropriate action, and select the OK button to complete the editing process. If you have chosen
to upload the local copy, the Content Director will send the modified document to the server and perform
an automatic check in.

The Content Director Upload Dialog

10. Editing Document Properties
If you would like to view or modify document properties for a document, select the results-grid row of a
document to modify followed by the Document Properties menu item from the Modify menu. Your left
frame will disappear and the right frame containing the Document Properties will appear.

If any key icons are displayed next to a field, you may select the Perform key-field lookup link to perform
a real-time field lookup. One or more of the fields will be updated.

If a Use Filing Rules checkbox is presented, you may choose whether or not the updated field information
will cause the document folder and file name to also update.

When changing the document type, you will not be able to modify the fields until the document has moved.

Make the necessary changes to the document properties and then click  when finished.

Note

System fields appear below the  button and are presented for informational purposes only.
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The Document Properties Frame

11. Viewing Document Version History
Content Central keeps track of document revisions and changes. The current version of a document will
always be displayed in results grids. To view all versions of a document, select the Document History
menu item from the View menu.

The number to the left of the decimal is the Major Version. The number to the right of the decimal is the
Minor Version. The following table outlines how versions are generated.

Major Version Added
Added as Copy
Moved
Checked In
Appended
Replaced
Uploaded Revision

Minor Version Properties Updated
Begin Approval Process
Approved
Voted for Approval
Rejected
End Approval Process
Set Priority
Added/Updated Retention Policy
Removed Retention Policy
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Viewing Document Version History

12. Viewing a Packet
Packets are collections of documents that share a key-field value. One or more packet templates can be
defined by your administrator and used to link these related documents together in a packet. To view other
documents linked to the currently selected document, select the Packet menu item from the View menu.
When more than one packet exists for the source document, you can choose the packet to view by selecting
the appropriate packet template from the drop-down menu in the header.

An informational message appears to the right of the menu indicating whether the packet is Complete or
Incomplete. When a packet is incomplete, rows representing the missing document types will appear at
the end of the current page of packet documents.

Viewing a Packet
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13. Renaming a Document File Name
To rename a document file name, select the Rename menu item from the Modify menu.

Provide a New Name for the file. Select the  button to rename the file.

Renaming Documents

14. Deleting Documents
To delete one or more documents in your results grid, add a check to each row of the documents you would
like to delete. When deleting only one document in your results grid, select that row.

Note

If you wish to delete multiple documents and the selected row does not contain a check in its
checkbox, Content Central will only delete that selected row's document.

Once you've selected and/or checked the appropriate row(s), select the Delete menu item from the
Document Actions menu. The Delete Document(s) dialog will appear.

Review your selections, then select the  button if you wish to continue. The documents will be
removed from the system and the Delete Document(s) dialog will close.

Deleting Multiple Documents
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15. Uploading Revisions
To upload a revision, select the Upload Revision menu item from the Modify menu.

Browse to the local file for each document you want to upload as a revision. After choosing your files,

select the  button to begin the upload process. A new version will be created for each uploaded
document.

Uploading Revised Documents

16. Checking Out/Checking In Documents
16.1. Checking Out Documents

When you need to make changes to the content of one or more documents in your results grid, add a check
to each row of the documents you would like to check out. When checking out only one document in your
results grid, select that row.

Note

If you wish to check out multiple documents and the selected row does not contain a check in its
checkbox, Content Central will only check out that selected row's document.

Once you've selected and/or checked the appropriate row(s), select the Check Out/In menu item from the
Modify menu. The Check Out/In Document(s) dialog will appear.

Review your selections, then select the  or  button if you are satisfied. The Check Out/

In Document(s) dialog will reload and those documents that were checked out will allow you to 

the documents or  the check out process.

Note

Multiple documents will be compressed into a ZIP file for download.
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Checking Out Multiple Documents

If any of the documents you selected for check-out were already checked out by another user, you may
request that those documents be checked in. You can send a notice to both the user and administrators.

Requesting Documents to be Checked In

If you do not have permission to check out any of the selected documents, you will receive a message
listing those documents. You will not be able to check out those documents.
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Attempting to Check Out Documents Without Permission

16.2. Checking In Documents

After you've finished modifying documents, you may upload the new file(s) back to Content Central. The
easiest way to accomplish this is by accessing these checked-out documents from your Folders frame.

Access the Folders frame by selecting the  button from the main menu.

The Folders Frame

Select the  icon in the Folders frame to obtain the list of documents you currently have checked out.
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The Checked Out Document List

Just as before when checking out documents, add a check to each row of the documents you would like to
check in. When checking in only one document in your results grid, select that row.

Once you've selected and/or checked the appropriate row(s), select the Check Out/In menu item from the
Modify menu. The Check Out/In Document(s) dialog will appear.

Review your selection(s), then browse to each document location on your local machine.

Select the  button when you are ready to upload the modified documents. The Check Out/In
Document(s) dialog will reload after uploading completes, and those documents that were checked in will
now be allowed for check-out once more. If you are finished, close the Check Out/In Document(s) dialog.

Checking In Multiple Documents
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17. The Approval Queue [Enterprise Edition]
Your Approval Queue contains documents or packets that have been routed to you based on an approval

process. Access it by first selecting the  button from the main menu followed by the  icon from
the Folders frame.

Icons displayed in the Approval Queue are as follows:

 Document or packet is a new arrival to the approval process.
 Document or packet has been approved.
 Document or packet has been rejected.

To narrow your view by catalog or document type, select from the drop-down list at the top of the results
frame.

After you've performed your designated task(s) related to a document or packet, you can either Approve
it or Reject it from the Approval Queue menu. One or more documents and packets can be approved or
rejected at the same time.

Note

You may be able to select only the first item in the queue. This is an administrator preference.

If you have permission to set priorities, you may select the Set Priority menu item from the Approval
Queue menu.

Most documents or packets arrive on an approval process because they match certain criteria during the
capture process or match criteria in a workflow rule; however, it's sometimes necessary to manually place
an existing document or packet on an approval process. To accomplish this, select one or more documents
or packets from your results grid, and then select the Start Approval Process menu item from the File
menu.

When you are viewing a packet, you may choose the Start Packet Approval Process menu item from
the File menu to assign the packet to an approval process.
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The Approval Queue

17.1. Approving

You can provide a note for the next user or completion of the process for each item you are approving.

If you are presented with a Send to user drop-down list, select one user from the list to be the recipient
of the item.

If you are presented with a PIN Required message, you must provide your personal identification number,
which can be defined in your options. See Section 5.8, “PIN” for more information.

Confirm your selections and select the  button to move the item(s) forward on the approval process.
The item(s) will be removed from your Approval Queue.

Approving

17.2. Rejecting

You can provide a note for the previous user or completion of the process for each item you are rejecting.

If you are presented with a Send to user drop-down list, select one user from the list to be the recipient
of the item.

If you are presented with a PIN Required message, you must provide your personal identification number,
which can be defined in your options. See Section 5.8, “PIN” for more information.

Confirm your selections and select the  button to send the item(s) backward on the approval process.
The item(s) will be removed from your Approval Queue.
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Rejecting

17.3. Assigning to an Approval Process

If one or more items to assign are the primary document type for one or more packets, you may choose
whether the Assignment Type is for only the Document or for the entire Packet. If the Packet option
is selected, choose a packet from the accompanying list. You can select the View Packet link to view all
documents in the selected packet.

Select the appropriate approval process for each document you've chosen for assignment. You may
optionally set the priority for the item and provide a note for the first member in the approval process.
If you are presented with a Send to user drop-down list, select one user from the list to be the recipient
of the item.

After confirming your selections, select the  button. The item(s) will be placed on the respective
approval process.

Assigning to an Approval Process
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17.4. Setting Priorities

Select the appropriate priority for each item listed. After confirming your selections, select the 
button. The item(s)' priority will be updated.

Setting Priorities

17.5. The Admin Queue [Administrators]

The Admin Approval Queue provides a view of all items on all approval processes for document types
you can administer. As an administrator you can approve, reject, or set priority on any of the items listed.
You can also remove any of the items from their approval process using the Remove from process menu
item on the Approval Queue menu.

To enter this view select the Admin Queue link at the top of the results frame. To narrow the view by
document type, select a document type from the drop-down list at the top of the results frame.

To return to your personal Approval Queue, select the My Queue link.

17.6. History [Administrators]

The History area provides a view of items that have been previously approved, rejected, or removed from
approval processes of all document types you can administer.

To enter this view select the History link at the top of the results frame. To narrow the view by document
type, select a document type from the drop-down list at the top of the results frame.

To return to your personal Approval Queue, select the My Queue link.

18. The Work Queue [Enterprise Edition]
Your Work Queue contains documents that have been routed to you on an ad hoc basis. Access it by first

selecting the  button from the main menu followed by the  icon from the Folders frame.
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To narrow your view by catalog or document type, select from the drop-down list at the top of the results
frame.

After you've performed your designated task(s) related to a document, you can either Move it or Remove
it using the Work Queue menu. One or more documents can be moved or removed at the same time.

The Work Queue

18.1. Assigning or Moving Documents to a Work Queue

To assign one or more documents to one or more users or groups, select one or more documents from your
results grid, and then select the Send to Work Queue menu item from the File menu.

Note

When assigning a document to a Work Queue from the Work Queue, select the Copy to Queue
menu item from the Work Queue menu instead.

To move documents from your Work Queue to another user or group, select the Move to Queue menu
item from the Work Queue menu.

Documents are grouped by document type. You can choose one or more users or groups to assign each
document group if your administrator has provided you with permission to assign to other users and groups.
Selecting the Send to My Queue checkbox will send the document group to only your Work Queue.

You can choose to set an expiration on the selected documents. Each expired document will be
automatically removed from the Work Queue. You may be limited on how long a document can exist in
the Work Queue.

After confirming your selections, select the  button. The documents will be sent to the user(s) and/
or group(s) selected. When moving one or more documents, the documents will be removed from your
Work Queue.
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Assigning Documents to the Work Queue

18.2. Sharing Documents

To share documents with guests or users, select one or more documents from your results grid, and then
select the Share menu item from the File menu.

Select the  button to add one or more recipients by e-mail address. While adding recipients, you
can select the Address Book link to access existing e-mail addresses. When providing more than one e-
mail address at a time, separate each with a semicolon.

You can choose to set an expiration on the selected documents. Each expired document will be
automatically removed from the Work Queue. You may be limited on how long a document can exist in
the Work Queue.

After confirming your selections, select the  button. The documents will be sent to the recipient(s)
selected. If any of the recipients do not exist in the system, a new guest user will be created, and an
invitation containing login details will be sent to the e-mail address provided.



Managing Documents

65

Sharing Documents

18.3. Removing Documents

To remove one or more documents from your Work Queue, select the appropriate documents in your
results grid followed by the Remove from Queue menu item from the Work Queue menu. Confirm your

selections and select the  button. The documents will be removed from your Work Queue.

Removing Documents from the Work Queue

18.4. The Admin Queue [Administrators]

The Admin Work Queue provides a view of all documents in each user's Work Queue for document types
you can administer. As an administrator you can assign or remove any of the documents listed.

To enter this view select the Admin Queue link at the top of the results frame. To narrow the view by
document type, select a document type from the drop-down list at the top of the results frame.

To return to your personal Work Queue, select the My Queue link.

18.5. Changing Expirations

To change the expiration of one or more documents in the Admin Work Queue, select the appropriate
documents in your results grid followed by the Set Expiration menu item from the Work Queue menu.
You may be limited on how long a document can exist in the Work Queue. Confirm your selections and

select the  button. The new expirations will be set on the selected documents.
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Changing Expirations of Documents in the Admin Work Queue

19. Custom Retention Policies [Enterprise
Edition]

The Custom Policies folder contains documents having retention policies differing from the document-

type retention policy. Access it by first selecting the  button from the main menu followed by

selecting the  icon from the Folders frame.

The Custom Policies Folder

19.1. Defining Custom Retention Policies

To override the default retention policy for one or more documents, select the Set Retention Policy menu
item from the Modify menu.
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First, choose the length of time each document should be retained in the catalog. You can alternatively
select the Retain Indefinitely checkbox to prevent the document from being removed at any time. To
remove a custom retention policy, select the Remove policy checkbox.

Select the  button to save your changes.

Defining Custom Retention Policies

20. The Catalog Browser
The Catalog Browser within the Folders frame displays documents as they appear on the file system.

Access the Folders frame by selecting the  button from the main menu. Select the  icon in the
left frame to display the browser tree.

Files within the selected folder will appear in the results grid, and document actions may be performed on
one or more selected documents. Navigate the browser tree by selecting the expand (+) and collapse (-)
icons. If your administrator has enabled paging, you may see an additional row indicating the current page
number of subfolders along with Prev and Next controls to navigate through the subfolder list. You can
also enter a number in the empty textbox to advance to a specific page of subfolders.
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Browsing Files Within a catalog

20.1. Cut, Copy, & Paste
The Edit menu can be used to Cut & Paste or Copy & Paste selected documents in the results grid from
one folder to another.

The Edit Menu

20.1.1. Cut & Paste (Move)

1. Select one or more documents from the results grid displaying the items to cut.

2. Select the Cut menu item from the Edit menu.

3. Select the new folder to move the documents into.

4. Select the Paste menu item from the Edit menu.
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20.1.2. Copy & Paste (Copy)

1. Select one or more documents from the results grid displaying the items to copy.

2. Select the Copy menu item from the Edit menu.

3. Select the new folder to copy the documents into.

4. Select the Paste menu item from the Edit menu.

20.2. The Context Menu
Access the context menu by right-clicking any folder in the Catalog Browser tree in the left frame. The
following operations can be performed using the context menu:

New Folder Creates a subfolder within the selected folder. After selecting this
menu item, you need to enter a name for the new folder.

Rename Folder Allows you to rename the selected folder. After selecting this menu
item, you need to enter the new name for the existing folder.

Delete Folder Removes the selected folder from the selected catalog. The folder
must be empty.

Add Document(s) Loads the Drag & Drop Upload applet to upload new documents
or other content. For more information, see Section 6.2.1, “Using
the Context Menu or File Menu”.

Properties (Administrators) Allows the folder selected to be assigned to a specific document
type. For more information, see Section 20.3, “Assigning
Document Types to Folders [Administrators]”.

The Context Menu

20.3. Assigning Document Types to Folders
[Administrators]

The Folder Properties dialog allows administrators to assign a document type to the folder selected.
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If the Inherit Settings checkbox is selected, the selected folder will use the settings of its parent.

To assign a document type, uncheck the Inherit settings checkbox and choose the appropriate document
type.

Selecting the Hide folder checkbox will hide the selected folder from any user who does not have the
View permission for the selected document type.

Selecting the Apply to all subfolders checkbox will apply the selections to all subfolders.

Select the  button when you are finished.

After assigning a document type, documents landing in this folder from a drag-and-drop upload will inherit
the document type assigned.

Note

Assigning a document type to a folder overrides each user's default document type for the catalog
when performing a drag-and-drop upload.

Folder Properties
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Chapter 5. The Messages Folder
The Messages folder contains system message and notifications. Access it by first selecting the 

button from the main menu. Select the  icon in the Folders frame to display the Messages folder. A copy
of each message can be automatically sent to your e-mail address. For more information, see Section 5.2,
“Preferences”.

Icons displayed in the Messages folder are as follows:

 Message Unread

 Message Read

The following are some of the message types that can exist in your Messages folder:

Document Check-In Request This message will be sent to you when another user has requested
that a checked-out document be checked in, and you are the user
who has previously checked out the document. Some of these
documents may be in your Approval Queue [Enterprise Edition].

New Document in Approval Queue
[Enterprise Edition]

This message will be sent to you when a document arrives in your
Approval Queue. This notification can be enabled or disabled in
your User Preferences.

Zonal OCR Warning [Enterprise
Edition]

When the Capture Service processes a captured document with
zonal OCR, and the extracted text does not match the format of the
document-type field, a message will be sent to you indicating the
document to find in your Coding Queue. This notification can be
enabled or disabled in your User Preferences.

Unprocessed File Notification
(Administrators only)

When the Capture Service has trouble processing one or more
image files, a message will be sent to you indicating the problem
encountered along with the full path to the problem file(s). This
notification can be enabled or disabled in your User Preferences.

The Message Actions menu allows you to mark one or more messages as Read or Unread. You may also
Delete one or more messages from the list.
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The Messages Folder



73

Chapter 6. Mobile Site
The Content Central Mobile site is designed for mobile devices like smart phones and tablets. It contains
a subset of tools that are available in the full application.

1. Connecting to the Mobile Site
To access Content Central Mobile you will need to launch your preferred Web browser on your mobile
device and enter the URL (address) for Content Central. In most cases, your mobile device will be
automatically detected, and the mobile version of Content Central will be launched.

To access the mobile site manually, enter /mobile at the end of the URL for Content Central. For
example, if your Content Central URL is http://contentcentral.domain.comm/, the mobile
site will be located at http://contentcentral.mydomain.comm/mobile/.

Once you've successfully accessed Content Central Mobile, you will need to provide your Username and
Password. Use the same credentials you would use for the full site and select the Login button. To navigate
to the full version of Content Central, select the Full Site button.

If you would like to prevent having to log in each time, select the Keep me logged in checkbox.

Note

This option may not be available in all configurations. Selecting the Logout button on the main
menu will require you to log in again.

Logging In to Content Central Mobile

2. The Main Menu
The main menu is displayed after you login. From the main menu you can access the mobile versions of
the Approval Queue and the Catalog Browser. You can also Logout of the mobile site.
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The Main Menu

3. The Approval Queue
Your Approval Queue contains documents or packets that have been routed to you based on an approval
process. Access it by selecting Approval Queue button from the main menu.

Only one document at a time is displayed in this mobile version of the Approval Queue. Use the Previous
and Next buttons at the top of the page or the navigation menu on the next line to access other documents
in your queue.

Select the View/Save button to download the current document.

The center portion of the page describes various aspects of the current document as it relates to the approval
process.

To approve or reject a document, enter an optional Note for approval/rejection and select the Approve
or Reject button.

In some cases, you may need to select a specific user recipient for approval or rejection and/or enter your
personal PIN.

To return to the main menu, select the Home button. To logout, select the Logout button.

The Approval Queue
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4. The Catalog Browser
The Catalog Browser allows you to navigate through folders of documents you can access in the system.
Access it by selecting Catalog Browser button from the main menu.

The Catalog Browser

4.1. Folder View
The Catalog Browser is divided into two views: folder and file.The folder view is displayed when you
first enter the Catalog Browser. The navigation area at the top of the page keeps track of your location.
You can select an individual folder from this panel to jump directly to that folder.

To navigate into a folder, select any link from the left column. To view a list of documents for the listed
catalog folder, select the Documents link in the right column.

To move back one folder level, select the Back button at the bottom of the page. To return to the main
menu, select the Home button. To logout, select the Logout button.

4.2. File View
When selecting a Documents link, you will be presented with the file view. Just as in folder view, the
navigation area at the top of the page displays your current location. You can select an individual folder
from this panel to jump directly to that folder view.

Only one document is displayed at a time in file view. The navigation area below your current location
allows you to move to the Previous or Next document in the folder. The center portion of the page describes
the name of the current document as well as its catalog and document type.

Select the View/Save button to download the current document.

To move back to folder view, select the Back button at the bottom of the page. To return to the main menu,
select the Home button. To logout, select the Logout button.
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Appendix A. Supported File Types with
Existing Content

As of version 6.5.x these are the supported file types that the Catalog Service will recognize for existing
content and metadata.

Adobe Acrobat (*.pdf)
Ami Pro (*.sam)
Ansi Text (*.txt)
ASCII Text
ASF media files (metadata only) (*.asf)
CSV (Comma-separated values) (*.csv)
DBF (*.dbf)
EBCDIC
EML files (emails saved by Outlook Express) (*.eml)
Enhanced Metafile Format (*.emf)
Eudora MBX message files (*.mbx)
GZIP (*.gz)
HTML (*.htm, *.html)
JPG (*.jpg)
Lotus 1-2-3 (*.wk?, *.123)
MBOX email archives (including Thunderbird) (*.mbx)
MHT archives (HTML archives saved by Internet Explorer) (*.mht)
MIME messages
MSG files (emails saved by Outlook) (*.msg)
Microsoft Access MDB files (*.mdb)
Microsoft Document Imaging (*.mdi)
Microsoft Excel (*.xls)
Microsoft Excel 2003 XML (*.xml)
Microsoft Excel 2007 (*.xlsx)
Microsoft Outlook/Exchange
Microsoft Outlook Express 5 and 6 (*.dbx) message stores
Microsoft PowerPoint (*.ppt)
Microsoft PowerPoint 2007 (*.pptx)
Microsoft Rich Text Format (*.rtf)
Microsoft Searchable Tiff (*.tiff)
Microsoft Word for DOS (*.doc)
Microsoft Word (*.doc)
Microsoft Word 2003 XML (*.xml)
Microsoft Word 2007 (*.docx)
Microsoft Works (*.wks)
MP3 (metadata only) (*.mp3)
Multimate Advantage II (*.dox)
Multimate version 4 (*.doc)
OpenOffice 2.x and 1.x documents, spreadsheets, and presentations (*.sxc, *.sxd, *.sxi,
*.sxw, *.sxg, *.stc, *.sti, *.stw, *.stm, *.odt, *.ott, *.odg, *.otg,
*.odp, *.otp, *.ods, *.ots, *.odf) (includes OASIS Open Document Format for Office
Applications)
Quattro Pro (*.wb1, *.wb2, *.wb3, *.qpw)
TAR (*.tar)
TIF (*.tif)
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TNEF (winmail.dat)
Treepad HJT files (*.hjt)
Unicode (UCS16, Mac or Windows byte order, or UTF-8)
Windows Metafile Format (*.wmf)
WMA media files (metadata only) (*.wma)
WMV video files (metadata only) (*.wmv)
WordPerfect 4.2 (*.wpd, *.wpf)
WordPerfect (5.0 and later) (*.wpd, *.wpf)
WordStar versions 1, 2, 3 (*.ws)
WordStar versions 4, 5, 6 (*.ws)
WordStar 2000
Write (*.wri)
XBase (including FoxPro, dBase, and other XBase-compatible formats) (*.dbf)
XML (*.xml)
XML Paper Specification (*.xps)
XSL
XyWrite
ZIP (*.zip)
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Appendix B. Advanced Search Syntax

1. Search Requests
Content Central supports three types of full-text search requests:

Any Words An any words search is any sequence of text, such as a sentence or question. In this type
of search, use quotation marks around phrases, place a + in front of any word or phrase
that is required, and place a - in front of a word or phrase to exclude it.

Example B.1. Any-Words Request

banana pear "apple pie"
"apple pie" -salad +"ice cream"

All Words An all words search request is similar to an any words request expect that all of the words
in the search request must be present for a document to be found.

Boolean A search request consists of word or phrase groups linked by connectors such as AND and
OR, which indicate the relationship between them.

Table B.1. Boolean Search Requests

apple and pear both words must be present

apple or pear either word can be present

apple w/5 pear apple must occur within 5 words of pear

apple not w/5 pear apple must occur, but not within 5 words of
pear

apple and not pear only apple must be present

If you use more than one connector, use parentheses to indicate precisely what you want
to search for. For example, apple and pear or orange could mean (apple and pear) or
orange, or it could mean apple and (pear or orange).

Noise words, such as if and the, are ignored.

Search terms may include the following special characters:

Table B.2. Special Characters

? matches any character

= matches any single digit

* matches any number of characters

~~ range search

2. Words and Phrases
To search for a phrase, use quotation marks around it.
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Example B.2. Phrase Search

apple w/5 "fruit salad"

If a phrase contains a noise word, the search engine will skip over the noise word when searching for it.
For example, when search for statue of liberty, the engine would retrieve documents containing the word
statue, any intervening word, and the word liberty.

Punctuation inside of a search word is treated as a space. Example: can't would be treated as a phrase
consisting of two words: can and t.

3. Wildcards
A search word can contain the wildcard characters * and ?. A ? in a word matches any single character,
and a * matches any number of characters. The wildcard characters can be in any position in a word. For
example:

appl* would match apple, application, etc. *cipl* would match principle, participle, etc. appl? would
match apply and apple but not apples. ap*ed would match applied, approved, etc.

Use of the * wildcard character near the beginning of a word will slow searches somewhat.

The = wildcard matches any single digit. For example: N=== would match N123 but not N1234 or Nabc.

4. Fuzzy Searching
Fuzzy searching will find a word even if it is misspelled. For example, a fuzzy search for apple will find
appple. Fuzzy searching can be useful when you are searching text that may contain typographical errors,
or for text that has been scanned using optical character recognition (OCR).

Add fuzziness selectively using the % character. The number of % characters you add determines the
number of differences the search engine will ignore when searching for a word. The position of the %
characters determines how many letters at the start of the word have to match exactly. Examples: ba%nana:
Word must begin with ba and have at most one difference between it and banana. b%%anana: Word must
begin with b and have at most two differences between it and banana.

5. Phonic Searching
Phonic searching looks for a word that sounds like the word you are searching for and begins with the
same letter. For example, a phonic search for Smith will also find Smithe and Smythe.

To ask the search engine to search for a word phonically, put a # in front of the word in your search request.
Examples: #smith, #johnson

6. Stemming
Stemming extends a search to cover grammatical variations on a word. For example, a search for fish
would also find fishing. A search for applied would also find applying, applies, and apply.

To add stemming selectively, add a ~ at the end of words that you want stemmed in a search. Example:
apply~ The stemming rules included with the search engine are designed to work with the English
language.
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7. Numeric Range Searching
A numeric range search is a search for any numbers that fall within a range. To add a numeric range
component to a search request, enter the upper and lower bounds of the search separated by ~~ like this:
apple w/5 12~~17. This request would find any document containing apple within 5 words of a number
between 12 and 17.

Note

A numeric range search includes the upper and lower bounds (so 12 and 17 would be retrieved
in the above example).

Note

Numeric range searches only work with positive integers.

Note

For purposes of numeric range searching, decimal points and commas are treated as spaces
and minus signs are ignored. For example, -123,456.78 would be interpreted as: 123 456 78
(three numbers). Using alphabet customization, the interpretation of punctuation characters can be
changed. For example, if you change the comma and period from space to ignore, then 123,456.78
would be interpreted as 12345678.

8. AND Connector
Use the AND connector in a search request to connect two expressions, both of which must be found in any
document retrieved. For example: apple pie and poached pear would retrieve any document that contains
both phrases. (apple or banana) and (pear w/5 grape) would retrieve any document that (1) contains either
apple OR banana, AND (2) contains pear within 5 words of grape.

9. OR Connector
Use the OR connector in a search request to connect two expressions, at least one of which must be found
in any document retrieved. For example, apple pie or poached pear would retrieve any document that
contained apple pie, poached pear, or both.

10. W/N Connector
Use the W/N connector in a search request to specify that one word or phrase must occur within N words of
the other. For example, apple w/5 pear would retrieve any document that contained apple within 5 words
of pear. The following are examples of search requests using W/N:

(apple or pear) w/5 banana
(apple w/5 banana) w/10 pear
(apple and banana) w/10 pear

The pre/N connector is like W/N but also specifies that the first expression must occur before the second.
Example:
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(apple or pear) pre/5 banana

Some types of complex expressions using the W/N connector will produce ambiguous results and should
not be used. The following are examples of ambiguous search requests:

(apple and banana) w/10 (pear and grape)
(apple w/10 banana) w/10 (pear and grape)

In general, at least one of the two expressions connected by W/N must be a single word or phrase or a
group of words and phrases connected by OR. Example:

(apple and banana) w/10 (pear or grape)
(apple and banana) w/10 orange tree

11. NOT and NOT W/N
Use NOT in front of any search expression to reverse its meaning. This allows you to exclude documents
from a search. Example:

apple sauce and not pear

NOT standing alone can be the start of a search request. For example, not pear would retrieve all documents
that did not contain pear.

If NOT is not the first connector in a request, you need to use either AND or OR with NOT:

apple or not pear
not (apple w/5 pear)

The NOT W/ ("not within") operator allows you to search for a word or phrase not in association with
another word or phrase. Example:

apple not w/20 pear

Unlike the W/ operator, NOT W/ is not symmetrical. That is, apple not w/20 pear is not the same as pear
not w/20 apple. In the apple not w/20 pear request, the search engine searches for apple and excludes cases
where apple is too close to pear. In the pear not w/20 apple request, the search engine searches for pear
and excludes cases where pear is too close to apple.
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Appendix C. Supported Bar Code
Symbologies

As of version 6.5.x these are the supported bar code symbologies that the Capture Service will recognize
when one or more recognition zones have been defined in a document type.

Codabar
Code 11
Code 128
Code 128 (EAN-128)
Code 3 of 9
EAN-13
EAN-8
Industrial 2 of 5 (Code 25)
Interleaved 2 of 5
Matrix 2 of 5
Plessey
UPC-A
UPC-E
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